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1. Introduction 
 

1.1. The VRMW Virtual Reassembly System 

The Virtual Repair and Measurement System (VRMW) is a multi-purpose platform for virtual operations on digitized 

cultural heritage objects. The base system (Virtual Reassembly System) is concentrated on object reassembly tasks and 

measurements in a fully three-dimensional environment and supports collection management facilities and manual 

manipulation functionality. However, the system is modular and supports various extensions, such as the Erosion 

Simulator Module created by NTNU, which is provided and bundled as a separate edition of the software.  

The core tools, the reassembly sub-systems, the GUI and the 3D graphics engine were entirely implemented by the 

Athens University of Economics and Business Graphics Group, which reserves all rights of the software.  

 

1.2. How to Use this Manual 

This manual provides a description of the various generic parts of the VRMW and the reassembly functionality (Chapter 

3), explains the basic operations of the environment (Chapter 4, Chapter 6) and how to perform reassembly tasks 

(Chapter 5). The manual also includes detailed instructions for using the accompanying feature curve extraction tool 

(Chapter 7) and provides a step by step walkthrough for three typical use scenarios (Chapter 8). 

For other modules (apart from the reassembly and measurement modules), please refer to the corresponding module 

manuals. 
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2. System Deployment and Execution 

 

2.1. Requirements 

 64-bit Windows Operating System (tested on Windows 7) 

 OpenGL 3.3 compliant graphics processing unit (GPU) 

 Microsoft Visual Studio 2013 C++ x64 Redistributable files (included) 

 

2.2. Installation of the Demo System 

 Extract the PresiousDemo.zip onto a local folder 

 If the VS2013 Redistributable files are not installed, run the vcredist.exe in the /redist folder (Requirement 3) 

 

2.3. Running the application 

 Run the ReassemblyServerStart.bat and SegmenterServerStart.bat files to start the Reassembly and Preprocessing 

modules respectively. Allow access from Windows Firewall if requested. 

 Run VRMW.bat in the VRMW folder to start the application 
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3. Interface Overview 
 

The VRMW interface is split into six main elements in order to group user-computer interactions, in a manner similar to 

most GUIs associated with 3D data visualization and manipulation (see next figure).  

 

 

 

 

3.1. Menu Bar  

 

This widget provides convenient access to a list of application-specific operations. The menu entries are the following: 

File. The File menu contains the most basic application functions such as quitting the application, importing an .obj file, 

saving the current VRMW state, etc. 

 

1 

1 

2 
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 Open Workspace State: Imports a VRMW workspace file (*.vrmw). Imports 

objects, collection management and workspace settings to the current 

workspace. Any current information is discarded. 

 Reset Workspace: Reset’s VRMW to its default state. 

 Save Workspace State/As: Saves the current workspace to an external file 

(*.vrmw). Note: Module settings, collection management selection, repair 

objects and log files are not supported by this operation. 

 Exit: Exits the application. 

 Import Mesh (.obj): Imports an obj mesh into the VRMW system. If the input meshes has been previously 

processed through the reassembly module, any associated files will be detected and loaded as well. 

 

Reports. The Reports menu provides the user with a list widget containing log and report files corresponding to various 

operations within the VRMW system.  

 

 

 

System. The System menu allows for simple application-specific tasks via the Preferences sub-menu item. 
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Preferences-General tab. Holds configuration parameters for modifying the workspace plane unit’s and default save 

folder.  

Preferences-Reassembly Settings tab. Contains connectivity configuration for the reassembly module. 

Window. The Window menu provides quick-access to layout functions such as changing the visibility status of main 

toolbars and panels to enlarge the workspace viewport. 

Help. The Help menu displays basic application and licensing information. 

 

 

 

3.2. Collection Management  

The Collection Management panel provides access to objects or collections of objects and search facilities to filter 

objects based on both name and type. 

The Collection group supports collection specific-operations. For example, the user is able to import/export a selection 

of objects stored in a simple XML file. Practically, this feature allows for fast loading of specific collection types between 

different projects, such as a certain group of reassembled or eroded objects. 

The Filtered Objects group allows for easy and fast interaction with the VRMW workspace. Clicking the Show/Hide 

buttons inserts/removes all objects to the workspace. If a selection is active, this operation affects only the selected 

object(s). 

2 
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The object types have been grouped to the following categories: 

 Assorted. This is simply a general-purpose mesh which can be visualized 

but is not classified to an actual type. For example, an assorted object needs 

to go through the segmentation/classification process to become usable in 

and available to either the reassembly or the repair procedures. 

 Fragments. Fragments are polygonal meshes, which have undergone 

processing via the segmenter module and their segmented regions have been 

identified and classified to intact/fragmented. 

  Assemblies. This type contains a cluster of reassembled fragments. This is 

a compound (group) object; it can be expanded to show the list of 

reassembled fragments. Fragment entries in the collection participating in a 

reassembly cluster, are moved to a new reassembly group after the 

reassembler returns the grouping data to the VRMW.  

 Erosion. An eroded mesh indicates a single (non-aggregate) object, which 

has been eroded through the erosion simulator (module not included in the 

current system). This is a group object; it can be expanded to show the list of 

different erosion frames (or “epoch” samples).  

 

 

 

Objects. Each object widget is displayed using textual and image information relevant to each object as well as object 

specific controls. The current available controls are: 

 

 

 

 

 

Generic controls: 

 

 Insert all object-associated meshes to the workspace. Load the mesh if it hasn’t be already loaded. 

 Remove all object-associated meshes from the workspace. This simply changes the visibility to hidden. 

 Remove the object from the collection management entirely. 
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Type-specific controls: 

 

 Break the current reassembled cluster. 

Context Menu: Right-clicking in the object widget opens a context 

menu with generic and type-specific operations. The common option 

shared by all objects is the ability to change the unit type, essentially 

changing the scale at which the object appears in the workspace. 

 

 

3.3. Status bar – Console  

The Status bar is positioned at the bottom of the application’s window. Its’ main purpose is to display textual information 

regarding operations performed via the user interface. A console window is also attached, which displays the history of 

all messages that have appeared in the status bar and is available by clicking the “Open Status Console” button.  

 

 

 

 

3 
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3.4. Modules Panel  

The Modules panel is simply a stacked panel, which is responsible for the object communication between each different 

module. Each module is therefore associated with a separate tab. Additionally, a measurements tab is available, which 

performs measurements such as Euclidean and Hausdorff distance calculations. 

 

3.5. Workspace Toolbar 

The VRMW Workspace consists of a toolbar and an OpenGL window. The toolbar contains a set of buttons which perform 

operations associated with the workspace.  

 

 

Object Manipulation Tools. Loaded objects can be manipulated using 3D transformations such translation and rotation. 

A scale transformation is available as well, but is only enabled for “guide” objects. Change of dimensions for digitized 

objects is not allowed: 

  Object translation 

 

Object rotation 

 

 

Visibility Tools. Object focus functions are available for centering and zooming the view on a selected object or group 

of objects visible in the workspace. Also, an automatic rearrangement tool is provided to redistribute selected objects 

in order to avoid collisions and overlaps among them.  

Resets the camera view. The camera is positioned between the –Z (back) and Y (up) axis, looking at the center of 

the current bounding box and moved backwards in order to enclose all the available objects. 

 Focus to selected object(s) 

 Focus to all visible objects 

 

 

 

4 

5 

Unavailable in the 

current version 
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Auto-arrangement of visible object(s) (Note: group objects are considered as one object). 3D models, when 

loaded, may overlap with other objects. Furthermore, in a cluttered workspace, overlaps may occur during 

experiments. Auto-arrangement calculates the bounds of the objects and arranges them so that there is adequate 

spacing between them (see next figure). 

 

 

 

Viewing Tools. Viewing toggles are available to hide/show or remove a selected object or group of selected objects from 

the workspace. This functionality is identical to the generic controls available in the Collection Management for each 

object. 

Remove an object from the workspace. This simply changes the visibility to hidden. 

 Remove (delete) the object from the workspace and the collection management. 

 

Reassembly Tools. For experimentation purposes, manual linking of fragments is possible through the Reassembly 

Tools. Once the fragments are segmented, their segmented regions can be visualized (Facet mode) and their links 

manually adjusted (Constraints mode).  

 

 Enable Facet mode for all visible fragments.                Disable Facet mode for all visible fragments 

 

 

 



VRMW – Virtual Reassembly System Manual   

 
 

14   
 

Show fragment constraints (Enable Constraints mode). 

 

 

 

 Force a positive link between two fragment’s facets (Start/Select Fragment/Save).  

 Remove a positive link between two fragment’s facets (Start/Select Fragment/Save) 

 Force a negative link between two fragment’s facets (Start/Select Fragment/Save) 

 Remove a negative link between two fragment’s facets (Start/Select Fragment/Save) 

 Select the previous fractured facet of the selected fragment 

 Select the next fractured facet of the selected fragment 

     Break the current constraint operation 
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External Tools. Additional functionality is enabled via this tab. Currently only the Feature Curve Extraction Tool is 

available. 

Launches the Feature Curve Extraction Tool for a selected fragment. This utility detects and generates additional 

landmarks on the fragments that can be exploited in the case of a poor state of the contact surfaces to correctly 

align two or more fragments. 

 

3.6. Workspace  

This is the VRMW 3D Workspace, which relies on a high-performance graphics engine (XEngine) for the visualization and 

manipulation of the data sets. The workspace always displays an “infinite” plane. This can be considered as the reference 

plane of the objects. It is always centered at the center of the environment’s extents and automatically expanded to fit 

all visible objects. A three-axis gadget is always positioned at the center of the plane to indicate the absolute orientation 

(X,Y,Z axes). An automatically adjusted 4-light configuration is also available with the following lights: A “key” light 

positioned 50 degrees above the camera. Two overcast lights positioned 120 degrees and 240 degrees from the key light 

position. A bottom, low-intensity fill light, positioned 50 degrees below the camera. 

The 3D graphics engine internally handles 3D asset management, so when loading objects some meshes may not 

become immediately visible, since they are loaded in parallel in the background. 

Please note that for small desktop resolutions, or when the application runs as a non-maximized window, you may 

collapse the side bars using the small arrowhead beside their name to allow the workspace to expand and be able to 

work more comfortably. Using the arrow toggle again (the icon changes direction when the panel is in a collapsed state), 

you may revert the panel to its visible state. 

  

6 
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4. Basic Operations 

 

4.1. Object Input and Output 

To load a generic mesh into the workspace, use the FileImport Mesh option. Any 

valid mesh in the OBJ format can be imported this way. Before loading the model’s 

data, a popup dialog box requests the user to enter the correct units the mesh 

dimensions are measured in. Different digitization or creation procedures result in 

different metrics being used and since the OBJ format does not store actual units 

in the files, VRMW needs a conversion ratio of the input generic units to a physical 

scale. The units can also be changed after an object has been loaded, by right-

clicking on the object in the collection and selecting the “Units menu”. 

 

Alternatively, to load a group of meshes already in a collection, the 

CollectionImport button can be used from the collection panel (left side of the 

VRMW interface). A collection file is an XML file describing the parts in a collection 

and can be generated by the VRMW once more than one objects are present in 

the collection management sub-system. To export objects in the current 

collection, highlight the desired objects and use the CollectionExport button 

(see right). Select one or more objects and select Export Collection to export the 

associated files as an .xml file. Practically, this exports the complete filename of 

the associated mesh. Therefore, this process supports only assorted, fragments 

and assemblies object types. Group objects exported their fragment counterparts. 

The entire workspace state can be loaded and saved as a project, using the FileOpen Workspace State and FileSave 

Workspace State As menu items. The current state of the workspace is saved as a *.vrmw file. Module settings, collection 

management selection, repair objects and log files are retained by this operation. Importing the workspace will reset 

the current workspace and imports objects, collection management and workspace settings from the workspace file. 

File export operations are supported both directly and indirectly for the various object types, depending on their type: 

• Assorted: No export operation is provided since VRMW does not modify the original mesh that was loaded. 

• Fragment: No export operation is associated, as the associated information is automatically detected by VRMW. 

• Assemblies: Right-click in the group object, select Export Meshes and a save folder location. For each associated 

fragment in the group object, a new transformed .obj file will be placed at the save folder with filename: 

       <Save_Folder>\<fragment_name>_Assorted.obj 

• Erosion (on supported VRMW versions): The erosion process indirectly exports all associated files at the original 

object’s location. 
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4.2. Moving Objects to the Workspace 

The collection management panel lists all objects currently available for experimentation in VRMW. Using the various 

type filters and/or textual search, you can isolate the desired sub-group of objects of interest. However, the objects in 

the collection, although can take part in a VRMW procedure (e.g. reassembly), they cannot be directly manipulated or 

visualized, unless transferred to the main workspace. To insert an object to the workspace press the  icon on its entry. 

Once moved to the workspace you can press the  icon either form the collection item entry or the workspace toolbar. 

To completely remove an object from the collection, click the  button. 

 

4.3. Handling and Viewing Objects in the Workspace 

View Manipulation. The initial user position looking down at the Z axis at a 45-degree angle. The camera model is the 

pinhole camera model with a vertical field of view of 60 degrees. The user control bindings are: 

 Left mouse button: Rotates the camera around the plane’s center. 

 Right mouse button: Zoom 

 Middle mouse button: Panning  

 

Object selection. When the cursor is positioned on top of an object the user control bindings are overridden for the left 

mouse button: 

 Left mouse button: Object selection. To unselect, click everywhere else. 

 Ctrl + left mouse button click: Multiple object selection 

 Ctrl + left mouse dragging: Rubber band mode. A rectangle is created in window space which selects all underlying 

objects.  

 

Object highlighting (mouse over - hover). Placing the cursor on top of an object highlights it in blue color. Selecting an 

object changes its color to yellow and the object’s bounding box is set visible. 

                        Default                                             Mouse over                                             Selection  

 

 

 

Object manipulation. Objects can be transformed based on the Object Manipulation Tools. Once an object is selected, 

it can be translated, rotated or scaled. This currently occurs on a two-click fashion, which is subject to change (Figure 3). 

For example: 
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 Select an object using the Object selection feature 

 Select the desired control from the object manipulation tools:  This operation also shows the appropriate 

engine transformation widget. 

 Select the desired axis of transformation. 

 Using the left-mouse button, drag either the selected axis or the object. 

 

 
 

 

4.4. Logging 

VRMW generates log files which store a list of time-ordered events. All events are associated with a verbose level. 

Currently, the available verbose levels are: 

• Debug: starts with “Debug”. Not available currently in the deployed version. It displayed messages only for debug 

purposes. 

• Error: starts with “Error”. It indicates a serious error in the execution of VRMW, for example failure to write a file 

in a physical location. These errors should not normally occur. 

• Warning: Starts with “Warning”. It indicates a problem in the execution of an operation. It does not crash the 

application, but it could limit the interaction of the user with the application. For example, failure to load a 

module. 

• Info: These messages do not have an associated prefix. Typically, they indicate the flow of operations. For 

example, when a module operation has started/completed/stopped. 

Debug level is initially disabled. This can be enabled by starting VRMW with –debug as a command argument. Three 

different log files are stored in the Log folder: VRMW_Log.txt logs events concerning the graphical user interface of the 

application. XEngine_Log.txt logs events concerning the graphics engine. Hardware_Analyzer.txt queries the operation 

system during the start of the application and logs useful information regarding the system’s capabilities. 
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5. The Reassembly Procedure 

 

5.1. Overview 

In order for a mesh to be available for reassembly, it must 

undergo a pre-processing procedure. Meshes that have already 

been pre-processed need not be re-processed again, unless 

desired by the user. The pre-processing converts a generic mesh 

into a “fragment”, which encapsulates the original geometry of 

the object plus additional information that is important for the 

clustering and measurement operations, such as the 

identification of potential fractures etc. 

All work related to the reassembly procedure is performed via 

the Reassembly module panel on the right side of the VRMW 

interface. If not already in an expanded state, click on the 

“Reassembly” module pane to expand its options. The steps 

required in general for running a reassembly task on generic 

objects are the following, and are reflected as individual steps in 

the reassembly module interface (see figure on the right): 

 

 Segmentation. Splits a single selected object into regions of similar properties. For example, smooth contiguous 

areas are clustered together and separated from a craggy irregular part of the surface, which potentially signifies a 

damaged or fractured region. To start the segmentation, a single object must be selected. Objects that have 

undergone the segmentation before, need not be segmented again, as their segmentation data are automatically 

stored along with the geometry in the file system. 

 Classification. This is a user-driven task for identifying potentially broken surfaces, which will be candidates for 

matching with other broken surfaces during the reassembly step. This process is available for objects that have been 

previously segmented. Therefore, classification is enabled for single selected segmented objects. 

 Reassembly. The main part of the procedure is enabled only for multiple selected objects and performs the 

clustering and alignment of fragments to form aggregate, reassembled objects. It is required that all selected objects 

intended for reassembly be segmented and classified prior to running the reassembly task, otherwise the 

corresponding button remains greyed (inactive).  

 

5.2. Preprocessing - Segmentation 

The segmentation and facet classification process are the two operations performed during the preprocessing step. 

Upon a successfully preprocessing operation, an “assorted” object is automatically converted to “fragment”. 

The user can select an assorted or already fragmented object and perform the preprocessing step by clicking the “Start 

Segmentation” and “Start Classification” buttons. Each step is associated with a set of parameters provided by the 
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module. Further modification of segmentation parameters such as segmentation strategies and merging criteria are also 

exposed through the “Advanced Settings” button. 

Note: While the classification process is a logical step that follows the segmentation task and can be performed 

individually by the user, each segmentation task also automatically performs a default classification of the resulting 

regions in order to set the intact and fractured surfaces based on the newly identified segments. This is done to facilitate 

the quicker setup of a reassembly experiment but also ensure that the minimum requirements are met for generic 

objects raised to the “fragment” status. 

The options (main and advanced) available through the 

segmentation task are shown in the figure on the right and are 

provided below. Please note that most of them are for detailed 

experimentation (Advanced Settings section) for optimal 

segmentation. Typically, the first three parameters are needed 

and therefore the Advanced Settings panel is collapsed. 

Segment Area Limit: After the standard segmentation process 

finishes and no more segments can be merged based on the 

threshold criteria, segments with smaller % area of the fragments 

total area, are decomposed and their elements are merged onto 

their neighboring ones. 

Local Boundary Radius: This setting is used only when the Local 

Neighbourhood criterion is selected. Defines a local 

neighbourhood around each vertex and plays role in the merging 

operations. This can also affect the algorithms performance 

(larger values result in more operations) 

Threshold: This is the stopping criterion for the merging 

operations of the segmentation process. Smaller values result in 

more conservative results. 

 

 

 

Advanced Settings: 

Segmentation Strategy: Defines the segmentation strategy and can be one of the following: 

 FIFO Region Growing: The faster and the more greedy approach (Updates one segment until no more elements can 

be merged on it)  

 BEST-First Region Growing: Better selection of the next merge operation. (Updates one segment until no more 

elements can be merged on it)  

 Hierarchical (Agglomerative): A bottom up approach that updates all segments based on the best-first merging 

criterion. Examines more thoroughly the search space but is slower (especially when using the Local neighbourhood 

criterion) 
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Merging Criteria: Defines the merging criterion of the segmentation process and can be one of the following: 

 Local Neighborhood Average Normal: The merging decision is based on a local neighbourhood around the 

examined element. Can handle curved surfaces. 

 Segment Average Normal: The merging criterion is based on the whole segment. Very efficient on planar surfaces 

with very good performance, but cannot handle curved surfaces. 

Enable Post-Processing: A usual threshold based segmentation results in over-segmentation. If enabled, small segments 

are merged based on the Segment Area Limit described earlier. 

User Post-Processing Extra Parameters: Enables some extra filters for the post-processing operations 

 Merge Segments Angle Deviation Limit: Defines a hard limit based on angle deviation based on which neighboring 

segments cannot be merged. 

 Merge Segments Normal Variance Limit: Defines a hard limit on normal variance deviation based on which 

neighboring segments cannot be merged. 

 Perimeter-Area Ratio: Defines a perimeter – area ratio based on which some segments are not decomposed 

 Ignore Exception Area Limit: Defines a second area threshold, below which the above rules do not apply. 

 

 

5.3. Preprocessing - Classification 

A default classification pass is applied to a newly segmented object anyway. To perform a custom classification in order 

to fix incorrect identification of regions as intact or fractured, use the Classification panel provided on a selected 

(segmented) object.  

Important: The goal of the classification is to positively identify potentially fractured areas. The more accurate the 

selection, the more accurate and fast the reassembly stage will be in clustering and arranging the fragments in space. 

However, sometimes “over-classification” is unavoidable, but this is just fine for most cases. Over-classification is the 

marking of intact faces as fractured. This may happen a) when ornate or engraved surfaces are present, with similar 

characteristics in terms of graininess as the fractured faces, b) when the fractured areas are smoothed out by erosion, 

c) when fractured areas exhibit a smooth transition into intact ones (again) due to erosion. The user should adjust the 

sensitivity settings (see below) to optimally discriminate the two classes of areas. Please take caution not to omit 

important fractured regions, as these will not be subsequently compared against other fragments in the reassembly 

stage.  The classification settings are the following:  
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Feature: Defines the feature that will be used for the classification and is one of following: 

 Local Bending Energy 

 Normalized Sphere Volume 

Measure: Defines the statistical measure to be used for the classification 

 Average: Based on the average value. 

 Median: Based on the median value (better with outliers). 

 Variance: Based on the variance on a small radius. 

 Local Variance Average: Based on the variance of the average on a local radius around each element. 

 Local Variance Median: Based on the variance of the median on a local radius around each element. 

 Local Variance Variance: Based on the variance of the variance on a local radius (larger than the one used for the 

variance) around each element. 

Scale: Defines the scale of the damaged (fractured) surface grain to be detected. 

Limits: Selects the detection (discrimination) limits of the above metric values used to classify the segments as definitely 

intact or fractured. 

 

5.4. Reassembly  

The Reassembly step is initiated for any objects classified as fragments; the preprocessing step has been already 

performed. A reassembly session is initiated by selecting two or more fragments, choosing a default set of parameters 

(i.e. a preset) and clicking the “Start Reassembly” button. Similar to the segmentation step, further refinement is 

available through the “Advanced Settings” button. 

Upon successful completion of a reassembly process fragments are grouped into zero, one or more “assembly” objects 

and automatically imported in the workspace, if not already there. The objects are also grouped in the collection 

management panel to form an aggregate object.  

The basic reassembly settings are shown in the following figure; The user must select one out of four ready-made 

presets, each one providing a different tradeoff between speed and accuracy. Two additional check boxes enable the 

use of salient feature curves detected on the intact surfaces (see specific section for this operation) and the reevaluation 

of the cached data (i.e. “Ignore Cache” option).  
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Results of all reassembly operations are generally cached for latter re-use so that the object-to-object comparisons are 

minimized for fragments already involved in previous experiments. The “Ignore Cache” essentially rebuilds the 

information concerning the currently possible fragment combinations and overwrites the cached data. Enable this 

option if the recorded results for the given sets of fragments are unsatisfactory and may cause problems or wrong 

pairings in the subsequent reassembly task(s). 

 

There are four PRESET options for the reassembly process, 

 Interactive: This preset initially performs a fast approximate alignment of the fractured surfaces, followed by an ICP 

process. 

 Fast: This preset uses an ESA optimizer between the initial alignment and the ICP process. The optimization step is 

configured for fast performance. 

 Medium: Similar steps to the previous preset, but with more steps on the optimization step. 

 Fine: Again similar to the previous steps, but this time with much more exhaustive settings both during the 

optimization and the ICP process. 

Use feature curves: If this is enabled, then feature curves are used in order to assist the reassembly process. Note: All 

fragments must have feature curves generated, using the provided tool. 

Ignore Cache: By default the reassembly results are cached in order to reuse them in the future. This flag ignores any 

existing cache entry. 

 

Advanced Settings: 

Finally, there is also the choice to use Custom Settings, where the user can specify a wide range of parameters. This set 

of options is intended for expert use only. 

Number of iterations: Defines the number of ESA optimizer iterations 

Number of passes: Defines the number of ESA optimizer restarts 

Disable Annealing: Disables the annealing optimization step 

Voxel Size: Distance queries are performed using signed distance fields. This settings defines the precision of the queries. 

Vertices Skip Step: Performance optimization. Uses a subset of the fragments points. 

ESA Maximum Distance: Defines the maximum distance that the optimizer will search. 

Penetration Penalty: A penalty multiplier for when surface alignment causes interpenetrations 

Norm: Can be one of the following 

 Average distance 

 k-th distance 

 Trimmed distance 

 L0-norm 
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Norm weight: Defines the value of the Lp-norm used in order to 

handle outliers 

Enable ICP: Enables the ICP process in order to refine the 

achieved alignment of two fragments 

Norm1: Can be either L2-norm or Lp-metric (Sparse-ICP) 

Norm2: Defines whether point-to-point or point-to-plane ICP 

will be used 

Outer/Inner ICP iterations: Define the ICP steps. Inner steps are 

used for the approximation of the rigid motion in case of 

iterative re-weighting 

Weighting: Defines the type of robust weight used (Ignored if Lp-

norm is used). Can be one of the following: 

 PNORM 

 TUKEY 

 FAIR 

 LOGISTIC 

 TRIMMED 

 MEDIAN 

 UNIFORM  

Weight: Controls the robustness parameter when the L2-norm is 

used, or the parameter p when the Lp metric is used. 

Enable Ransac: Uses Ransac for the initial alignment 

Ransac Iterations: The number of iterations 

Ransac Area Threshold: Defines the area of the bases 

Bases skip: Value to skip bases (performance) 

Vertex pair skips:  Another performance setting 

Curves weight: In case feature curves are used in the reassembly, defines their contribution 

Minimize penetration: In case feature curves are used, tries to minimize any penetration after the alignment operations 

have been performed. 

 

5.5. Reassembly Summary Report 

A specialized HTML “reassembly summary” report can be generated via the 

“assemblies” object context menu containing average, median distance and 

matching area information for each pair of fragments. The report also captures the 

current view of the workspace and highlights the names of the fragments involved 
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in a reassembly clustering for easier reference and can be sent, printed or manipulated in many standard ways. The 

following image shows an example reassembly report: 
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6. Measurements 
 

The measurements module is used to perform measurements within the 

VRMW workspace. Two types of measurements are currently supported: 

point-to-point Euclidean distance and Hausdorff distance between surfaces. 

Both measurements output the result in the console output window. The 

procedures for performing the measurements are the following: 

Euclidean Distance 

• Select one or more objects in the Collection Management and insert them in the workspace.  

• Open the Measurements tab in the Module Panel and select “Euclidean Distance”. Left-click on the two 

locations the measurement should occur, directly on the 3D objects. Any valid surface point can be used as 

an endpoint to this operation. 

• The console output should display the measured result. 

 

Hausdorff Distance 

This metric computes the root mean square (RMS) distance between samples on two surfaces. It is used here to assess 

the tightness of a coupling between two fragments. The same measurement is reported between all fragment 

combinations when producing a reassembly summary report, but the calculation can be performed independently for 

arbitrary fragments and their positioning. Due to the way the measurements are calculated, the Hausdorff distance 

always approximates the correct result, as all individual distance measurements are area-weighted, regardless of the 

distribution of points on the digitized surface. This way, the point cloud representing the sampled object needs not be 

uniformly distributed. During the measurement, all individual distance calculations between samples that fall beyond a 

threshold are discarded, thus associating the metric with surface parts being in contact with one another. To compute 

the Hausdorff distance, do the following:  

• Select two objects in the Collection Management and insert them in the workspace.  

• If the selected objects are not classified as “fragments”, proceed to pre-process the objects to convert them 

to fragments (see Reassembly Section). 

• Open the Measurements tab in the Modules panel and select “Hausdorff Distance”. Left-click on the two 

objects the measurement should take place on. 

• The console output should display the measured result. 
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7. Feature Curve Extraction Tool 

 

7.1. Purpose and Functionality 

Using the f-curve extraction tool the user can mark and generate feature curves from the intact regions of a fragment. 

The curves are sampled and exported as point sets which are later used in the reassembly process. This tool is provided 

as part of the VRMW system and although it can be run as a standalone application to process generic meshes, this 

mode of operation is not recommended. The main interactivity the user is involved with is to select regions of points on 

the model using a brush-tool and select actions to perform with them (see detailed instructions below).  

Detecting and subsequently storing salient formations on the intact parts of a fragment can greatly assist in the correct 

reassembly of objects when: 

• Fractured surfaces convey little usable information due to heavy erosion. 

• The objects to be reassembled are not fragmented, but rather represent building blocks of a larger construction. In 

such a case, there are inherently no broken faces and the reassembly system must solely rely on trivial compatibility 

of contact regions and the use of external features acting as “guides”. 

• The fragments are probably not adjacent to other parts but there is a high probability that they do belong to the 

same cluster nevertheless. In this case, no compatible surface-based match is likely to be found and only salient 

curves can constrain the pieces together.  

  

7.2. Launching the Tool 

The software is included in the VRMW bundle and is launched from within the application to mark feature curves on an 

already segmented and classified fragment model. To launch the tool, select a segmented and classified object and press  

 

If you want to launch the application independently, go to the [VRMWROOT]\Demo\fCurveExtract directory and 

launch the executable fCurveExtract.exe with the following minimum options: 

fCurveExtract.exe –visual –i [MESHFILE] 

For a complete list of options and their meaning, please type fCurveExtract.exe –h  

The required MESHFILE parameter is the object to load for the feature curve extraction and must be a valid mesh in 
the OBJ format, with or without an accompanying .mtl file. When launched through the VRMW, all appropriate 
parameters are automatically passed to the tool. 
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7.3. The User Interface 

 

 

In Panel 1 are the customization and selection options provided to the user. From top to bottom: 

Filtering mode options 

• Manual: The complete point-set selected by the user is used for the feature curve generation. Not recommended 

for most cases, as it requires precise manual selection of features. 

• Manual Filtering: The point set that the user has selected is filtered and only the maximum/minimum values of the 

measured feature metrics take part in the feature generation. 

• Directive Filtering: The point set that the user paints on the object is used only as a guide. An initial feature curve 

is extracted and extrapolated until no more neighboring points with similar descriptor values can be added to the 

feature curve point set. This is the recommended preset for most tasks. 

Show Selected Points: Enables or disables the visualization of the user selected points (Yellow when the feature set is 

focused, Gold when not in focus). 

Show Filtered Points: Enables or disables the visualization of the actual points used in the feature curve generation 

(Blue). 
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Show Extrapolated Points: Enables or disables the visualization of the extrapolation of the generated feature curves 

(Blue lines). 

Brush radius selection: Sets the scale of the brush selection tool 

Border ignore radius: Sets a distance threshold. Based on this size, points from the border edges are ignored in the 

feature generation process 

B-Spline Degree: The b-spline degree that will be used for the feature curve. Typically, use 2 

B-Spline Control Points: The b-spline control points 

Paint Fractured Areas: Lets the user mark fractured areas to alleviate short-comings of the segmentation process. Also, 

this tool should be used when no segmentation has been performed on the mesh (manual launch of the application for 

an arbitrary mesh). 

Visualize Fractured Areas: Lets the user visualize the points selected with the previous mode. (Purple) 

Erase mode: Switches the brush from adding points to a selection to removing them 

Save Feature: The selection of the user is stored here in a feature group. Only stored feature groups take part in the 

salient curve generation process. 

Feature List: Lets the user set the focus on one of the already stored feature-point sets for editing. 

Clear: Clears all the points of the selected feature point set 

Delete Feature:  Deletes the selected saved feature point set 

Scale selection measure: The statistic used for the detectable feature scale estimation. 

Percentage: Lets the user change the percentage based on which a descriptor value is considered as an extremum. 100% 

is in essence the whole user-selected group. 

Preview: Performs the feature extraction and shows the extrapolated curves. 

Store point data: Stores in .obj format the generated feature curves for visualization with external tools 

Finalize: Generates the feature curves and stores all appropriate files that will be used in the reassembly process. Exits 

the program. 

 

7.4. Feature Curve Extraction Procedure  

The basic procedure for marking feature curves is described in the following figure. First, select “Directive Filtering” in 

order to automatically detect continuity of similar features across the surface, even beyond the marked regions. Then 

paint a selection of points that include regions containing the desired feature. One or more disjoint regions may be 

selected, as shown in the first inset of the figure. The algorithm should be normally able to extract a unified feature 

curve from them. Press “Save Feature” to register the point set. Later, you may refer to this set and modify it using the 
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drop down list. By pressing the “Preview” button, the feature curve estimation starts, using all available point sets and 

the result can be seen in the middle inset. Finally, if the resulting set of points detected as features is too large, skewing 

the estimated curve, you may restrict the selection criterion changing the “Feature Percentage Used” slider (bottom 

inset).  
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As shown in the next figure (top left), a single point set selection may include parts of the geometry that overlap several 

detectable salient curves. In this particular example, using the option “Paint Extra Fracture Areas”, we have marked 

certain boundary points that have not been classified by the system as fractured, but can neither be characterized as 

“intact” due to the heavy smoothing from the erosion (magenta colored). Such points are likely to confuse the feature 

tracking algorithm since a) there is no abrupt transition, b) there exist high-descriptor values (adjacent to the edge) and 

c) the area links two truly salient point sets. Marking them as extra fracture points, prevents their inclusion in the brush-

based point selection. 

In the same figure (top right) the new point group, resulting from the 4 brush strokes, has produced two distinct feature 

line segments. The two bottom insets of the figure demonstrate that it is possible to create a point selection group that 

potentially overlaps a previous set, in order to detect a salient feature curve near another.  
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Finally, the “Paint Extra Fracture Areas” functionality can be used on unsegmented and unclassified meshes to manually 

draw areas where we do not want the feature curves to evolve into and must be considered as boundaries for the 

purposes of the curve extraction. This functionality however was not intended for generic objects but rather for the 

purpose of correcting results as shown in the above figure, so the use of arbitrary geometry that has not undergone a 

pre-processing is not the target application of the tool. 
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8. Example Scenarios 
 

8.1. Object Preprocessing 

Initially, launch the application: 

• Run the preprocessing server and the reassembly server by using the “SegmenterServerStart.bat” and 

“ReassemblyServerStart.bat” batch files  

• Open VRMW (vrmw.exe) 

Import an object directly via the File Menu or as part of a collection using the Import button in the Collection Filter. In 

the import wizard select the object’s units and click OK.  

Select an object in the Collection Management and click “Start Segmentation”. When segmentation ends, import the 

newly created “fragment” in the workspace and enable Facet Mode . The regions detected as potentially fractured 

are highlighted red.  

 

 

If desired, change the classification via the Classification Menu.  
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8.2. Object Reassembly 

Start the application as in the previous scenario. Import two or more objects directly via the File Menu or as part of a 

collection using the Import button in the Collection Filter. In the import wizard select the object’s units and click OK. 

Select two or more objects in the Collection Management. If the selected objects are not classified as “fragments”, follow 

the previous scenario first. 

Open the Reassembly tab in the Module Panel and select “Start Reassembly”. Once the reassembly process is finished, 

the “fragments” should cluster to a new “assembly” and show up in the workspace. 

 

 

 

 

8.3. User Constraints  

Here we show how to constrain two fragments via positive link, i.e. a link that enforces two facets to get “glued” together 

(white listing), disregarding the relative matching score of the connection with respect to the rest of the fragments. 

Conversely, a negative link is a repel constraint that forces the facets of two fragments to never be joined (black listing).  

To perform a positive link, select two objects in the Collection Management and insert them in the workspace. If the 

selected objects are not classified as “fragments”, follow Scenario 1 first. 

Step 1: Select “Force a positive link between two fragment’s facets”  in the toolbar. This initiates the user constraint 

mode. The start button of each link operation serves also as an intermediate state button. 
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Step 2: Select a fragment and press  to lock the fragment selection. 

 

Step 3: Use  or  to select the facet of the segmented fragment that will be included in the constraint and press  

to lock the facet selection. 
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Step 4: Repeat Steps 2,3 to select the second fragment and its facet 

 

Selecting the second fragment’s facet by presssing  automatically saves the current constraint, which is displayed as 

a line connecting the two facets. 

 

 

At any time during this operation, selecting  cancels the entire process. 

 

 

 


